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INTRODUCTION

The Provincial Plan for the Provinee of Biliran
1.3.2 Outline of the Report

Table 1.3.4 1 isl of Collccled Reporls and Documents

[ No. Title Year Sourte iG] C M
T T GENERAL -

1. |The Phitippine Natianal Development Plan

Program Master Plaaning 1998 NEDA -
2. [Report and Rcmmrmndauon cf !he President to

the Board of Dircelors on Proposed Loans to the

Republic of the Philippines for the Rural Water .

Supply and Sanitation Sector Project’ - May 1996 ADB -
3. {Report and Recomhmndatien of the Presiden to

the Board of Dicectors on a Proposed Lean 1o the

Republic of the Philippines for the Reg!ona!

Mumcnpal De\. clopment Project Aug. 1995 ADR =
4. Long Term a_nd Med:um Term Sector Dev'e

Planning Workshop No. 2 1998 DG
5. |Phitippine Agenda - A National Agends for .

Slt:!alnablvz‘ Dev elopmcn! for the 2{st (‘en!ury 1997 PCSD ' L
6. |Updated Medmm Term - :

Phitippine Dev :iopmem Plan 1996 - 1993 Dec. 1995 NEDA L]
7. {Water Supply, Sewerage ‘and Sanitation :

Master Plan of the Philippincs 1988 - 2000 1938 NEDA L
8. C‘ala!ogue Produ\.ls and Sen wes 1993 NAMRIA u
9. JThe Phitippines in 1995 Our Time Has Come Hune |§95 op : n
10, lAustratian De\'elopmenl Corporalion with the

Philippings - Phitippine Program Profile

{Section C.3) July 1997 LGU
11. }Socizl Reform Agenda Policy Directives Social Reform ' u

Council Secreiariat
L SOCIQ-ECONOMIC ©. - -0 o 7

1. [Socio-Economic Protilz (Biliran) PPDO
2. |Census-Based National and Regional Population .

Projection Volume t 1995 NSO -
3. |Repont No. 1-P: Fopulation by Province, City/

Municipality and Barangay

Region VUT 1993 Census 1995 NSO
4. [Report No. 2-87P: Socio Economic and

Demographic Characteristics Biliran 1995 Cersus June-05 NSO
5. |Philippine Statistical Yearbook 1997 NS(B L
6. NSO (‘eﬁsus by Province, Male, Fenuale and

Age Brackel 1995 NSO
7. |Geographic Coding and Urban and Rural

Classilication {Region Vill) 1990 NSO
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8. |Total Population, Houschold Population and
Number of ouscholds by Provinge, Ciiy/
Municipality and Barangay ' 1995 NSO =
B fo o T WATER SQURCE g
1. |Master Plan Study on Water Resources ) : :
© |Management in Republic of the Phitippines Vol. | Jan, 1998 NWRB 1=
2. |Master Plan Study on Water Resources
Managzment in Republic of the Philippines Yol, Il Jan. 1998 - NWRB ]
3 Philipbine Water Resousces Data Violume I
StrcamfNow and Lake or River Stage Jan. 1980 NWRC |
4. |Phitippiae Water Resources Dota Volume [} )
Streamflow and Lake or River Stage Jung 1991 - DPWH-BRS -
5. [Master Pian Stady on Water Resources : o :
Management in the Republic of the Philippines July 1997 NWRB ]
6. |Vopographic Maps 1:250,000 | Reprintedin .
Bitiran . _ 91,91 and 96 NAMRIA -
7. [Rapid Assessment of Water Supply Sources 932 NWRB : L
-~ |Bitiran . '
8. [Groundwater Resources Investigation Repon : Unpublished NWRB =
Bitiran : ) ‘ . .
9. |Water Resources Summary Data ‘
{Volume I and 2) ‘ P 1970 NWRB [ ] g
10. {Individaal Well Inventory _ 1590 NWRB : - g
Bikiran : : : : ' '
i1 Ground'\\'ater ofthe Philippinels : June 1980 NWRC u
12, [LWUA Water District Database o ew  LWUA -
13, |Road Network Map o n
I‘4. Well laveatory ‘ NWRB t
15, {well fventory ' | 1998 DPWH.DEQ n
f6. Well Dntting Record 1998 DPWH-DEO L]
Wl WATERSUPPLY - - R R T s b e e o
I JAssessment 61‘ the Domestic WS and Senitation
Sector of Eastern Visayas April-98 NEDA/UNIFEC =
2. |Yecknical Assistance to the Republic of the B
Philippines for the Water Supply and Sanitation .
Sector and Study : July 1997 . ADB u
3. [Working Group on Urbanization {(WG/U)yofthe
Water Supply and Sanitation Collaborative '
Council (WSCC} Sept. 1993 WSCC-WG/U =
4. |Water Suppy Feasibility Study Methodology . ' @ E
Manuab {LWUA-Mala Columbus) 1996 LWUA n ' '
5. |Ovenvicw of Water Priciﬁg Policies and Structures :
in the ESCAP Region 1996 UN
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6. |Repait and Recommendation of the President o Sepr 1596 ADR -
Board of Dircctors on a Proposed Eoantothe
LWUA in tha Republic of the Philippines forthe
Small Towns Water Supply Sector Project

V. |~ . ENVIRONMENTALSaANITATION | . . T T .1 1T 1
1. |Teaineds Train-ing Kits for Ssr;itation Mar. 1996 UNDPADILG "

2. |teological Ahemaﬁv.es in San.ila!ion Aug. 1597 SibA L

3 [The t‘odé Sanitation of the Phitippines 1976 DON =
VL INSTITUTIONAL

i. l Gerﬁleral Pfir;:er . Lgcal Gloven;\menl Code E-fw‘)l 1991 DILG n

2 l:hc Ba.rangay an;.! the Local Go‘.'emrln-:m.("odc 1994 DHG L]

JI. NEDA Board Resolution lNo. 4 (5. 1991) 19%4 NEDA I

4. |tnplenieating Retes and Regulations of
* INEDA Beard Resolution Mo. 4 (5. 1994), ’ ‘
Chuse {G) ‘ : - Nov. 1997 NEDA »

5. INEDA Board Resolution No. f, 5-94 ‘ 1994 NEDA n
6. |NEDA Board ResolutionNo. 5,896 1996 NEDA -
7. {NEDA Board Resolution No. 3, $-89 - 1989  NEDA -
3 I L COMMUNIFY DEVELOPMENT 77 | o o D s -
1. [Comumuaity l‘)e\'elopmen} Manual _ DPWIL/DILG/ |
IFirst Water Supply, Sewerage and Sanitation LWUA/DOI
Sectors Projects (FW4SP) C '
2. BWSA I-'ormulaﬁon Opera[ionls Manual ) DPWILDILG/ L

Commurity Develapment Maaual ‘ LWUADOH
First Water Supply, Sewerage and Sanitation :
Scclors Projects (FW4SP)

3. |lostitution Buitding for Decetralized Implemieniation
of Community-Managed Water Supply and ‘
Sanitation Projects OH.G =

4. [institution Buoilding for Decentralized Implement-
ation of Community-Managed Water Supply o ‘
and Saniation Projects June 1997 DG =

5. |Guidebook for Community Managed WATSAN

Project LINOP B
6. |A Manual for Training Trainers in Patticipatory PROWWESS/ -

Techniques 1690 UNDE

7. {Interception Report: for Speciai Assistance for
Projects Sustainability for the Rural Water Supply

L Project 1997 SAPS Team n
8. |interim Repori for Special Assistance for Projects
’ "+ {Sustainabitity for the Rusal Water Supply il
Projzct (SAPS) : 1997 SAPS Team n

9. |Participatory Action Planning for the Developmeni
of Two PSF Project - 1994 up
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(No ] ] Vear Source RIPIM]&]
10, |Waterand Sanitation for All: A World Prionity 19935 IRC {nteraational "
Achievenonts and Challenges Water & Social Center
11 [Comaunity Oeganizers' Manual, Part ) 1990 CSWCD-UP/DCTY
: DOPI
12. |A Handbock en Community Developrznt 1975 up ]
13 Acl-l.ie\'"ing Success in Commwunity Water Supply UNDP -
and Sanitation Projects
t4. Hiandbook on (‘ommumly Orqamzmg for Water DILG =
Sanitation
15, |Draft Final Répurl for Special Assistance for
Projocts Sustainability for the Rural Water Supply . : o
mn Prcgcct Feb. 1997 SAPS Team L
16. |A Manual on Convnumly Paﬂ:upalson in Water =
Supply and Sanitation (RWSSP)
17. Achleung Suecess in (‘ommunny \\fater Supply and
Sanzlahon Projects : 1980 WO
18, |Community Developmcnt Manual Nov. 1995 PIC -
FHl b GENBER - A
1. [Sourcebook for Gender Issues at the Policies Level . o
in the Water and Sanitation Sector Oct. 1996 {BRD/WR
2. |Gender tssues Sourucbo(\k for Water and Samtahon
Projects Jan. 1995 IBRDAWB
3. |Tookkit on Gender in Water and Sanitation
Serics No. 2 Aug 1996 UNDP
4, [)L\{‘LKSII\. Shallaw Well Waler Supplices the Fam:!y
Handpomp Scenario Feb. 1990 UNDP
5. {United Nalions Decade for Wonen 1976-1685
6. [Gender Mainstrea ming NCRFW -
7. Reglonal Memorandums Feb. 1997 DILG u
& Phl?lppme Pian for Gender D-.\e1opmen! 1995-2025 NCRFW =
9. Phihppme Country Reporl on Women Sept. 1995 NCRFW -
10. {A Primeron the GAD Focal Point 1596 NCRFW =
IX. “FINANCIAL R L; LR ",
b, {Anauat Investment Plans, Biliran PPDO ]
2. [Fanity Incoime and Expenditures Survey Vol. i 1994 N3O |
3. |Family Income and Expenditures Survey Vol. i 1964 NSO -
4. 1DMLG Memorandum Circular 96-263 1996 DILG L
$.  [Presidential Decree 1914 (MDY) 1984 Qe =
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[No. [ e - Year
6. |leint Curcular No. 6-87 Aug. 1987
7. [LeyteAccomphshment Repons,
19931996 1993-1994 PPDO ]
8§ ISuwement of Income-Expenditures
of Municipatitics PEDO [
trgmd;-

ADB . Asian Development Bank
BRC - Bureaa of Research and Stacdards
CSWCD - '(‘oH:'gc of Social Work and Comnwnity Development
DCD - Deganiment of Conununity Do clopment
DEOQ - District Enginecr Offie ‘
DILG - Departinent of Interior and kocal Government

DOH . Drp:mmcnlof Heaith

DOFI - Development Options Phnl:ppmcs te.

DFWH - Department of Works and Righways

1BRD - hltmmonal Bank for Reconstruction and D\:\:!opmt:m
16y, Locat Govemment Unit

LWUA - Lotal W ater Un!.mes Administration

MAMRIA - Nationa) Mapping & Rescurce Infonnation Autherity
NCRFW - National Commission in the Rele of Fibipina \\’omcn
NEDA - National Economic Developmen Authority

NSCS - National Statistizal Coordination Board

NSO - Nabional Statistics Office

NWREB - Naticual Waier Resource Bureau

NWRC - National Water Resourcs Council

OP - Oftice of the President

PC3D - Phitippine Couvmsel for Suskzinable D:»clopmﬂsl

PIC - PI‘D‘J'ECI lmf!cmenl':tim Consultants

PFDO - Provinciat Phasuing and Development Office

PROWIWESS - Promotion of the Role of Wenen in Water,
Environmental and Sanitation Seerces

SHA - Swedish Entermational Development Cooperation Agency

UN - United Nations

UNIFEC - United Nations Intemational Chabdren's Fund

UNDP - Uniled Nations Developinent roject

P - University of the Philippines

WATSAN - Water 21d Sanitation

WB - World Bank

WHO - World Health Organization

WSOC-WGL - Waler Supply & Sanitation Collaborative
Counci-Working Group on Urbanization

G - Global

C - Central Govemment Level

R - Regional Govenunent Level

P - Frovincial Leved

M - Manicipal Level

B - Baringay Level
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Annex 1 User’s Guide foy Computer-Aided Planning

R INTRODUCTION

The PWASP Data Managemoent User’s Guide explains the procedure of encoding Hala and generating

tables and figures for the PW4SP. The Guide consists of the following scctions.

. Section 2: hardware and software require'd to successfully run the PW4SP Data
Management System : '

. Section 3: the concept of the nmrocomputur architecture and an ov erview of hardware
configurations :

° Section 4: I‘undamemals to 0pcratc lhe systen with internal architecture
. Section 5: basic concept of software operation

. Section 6: a complctc list ol data files and worksheets in the PWd‘SP l)ah Management
System

s+ Scction 7: data tinkages |
. Scction 8: the procedure of upda!ing the PW45P

. Section 9: standard report formal

2. SYSTEM REQUIREMENTS

The tollowing are the basic requirements to successfully run the PW4SP data manageinent.

Hardware; _ Software:
Computer: Pentium Serles | _ Operatiﬁg Systém' | Window 95/98
RAM: 32 MB (minimum) Windows Package: MS-Office 97
Hard Disk: _‘ 3GB (mmxmum) . Spreadsheel ' MS-Excel 97
Floppy Dmc 3.5 inch, High Density | Word Processing: MS-Word 97
Monitor: . VGA Monitor B ‘
Printer; 30 cdlumn (Cen handle A4 size paper).

. Mquse:. ' Any brand that supported by MS-Windows

Miscelaneous: 500 watls Automatic Voltage
- Regulator and Surge Protector
UPS 450 walts



3. MICROCOMPUTER SYSTEM

Al computers, whether large or small, basically operate on the same fundamental principles. The
hardware and soltware of a mainframc computer and a microcomputer have (he same components

- and fulfill the lv-mc functions necc:\aly to any conputer systen.

The compulu 1S seCn as a po\\. () l'ul tool that can cnable us to expand the horizons of our knowledge.
It allow:. processing of Iargc volume of data or complcx pattein of information that would otherwise

be ditficult to organize and understand. Morcov et it allows for an casy mampu!almn of data.

There are (wo major components of a microcomputcr: thc hardware and the sofiwarc. These two

components complement each other in order to fulfill their basic function.

A microcomputer hardware is made up of several components based on the functions they perferm in

the system anid how they interact with the other components.
The principal clements of a compuler system are:

Central Processing Unit {CPU)

Main Memory (RAM)

Secondary Storage Devices (disk, drwcs magrietic tapes, cte.)
lnpub’Outpul Devices (monitors, prmtcrs, ctc.}

& & » @

. Thc CPU does the actual computmg Itis Lapable of smlplc anthmctlc and loglcal opcrations, such as
addmon and data comparison, that arc executed al excecedingly hlgh spced The power of a compulu
dueully stems from the speed and accuracy wnh which the CPU can carry out computahom and move
information around. The main memory of the computer is usualiy referred 10 as Rmm’om Aca’s;
Afemory or RAM. This parl of the computer contains thc progranis and information that are cmrcnlly
bcmg processed by the CPU. Secondary storage dcvuce such as magnetic disk, is capable of holdmg
large amount of data. Programs and data are normally stored on these sccoudary dcwccs and_cou!d
be retrieved when needed. Thcj.' are then loaded into the RAM ahd exceuted.  The results of the
proceséing can then be writlen into the secondary storagé device or scnt to an otutpu.t. device sucﬁ as
the monitor or pnnter Peripheral devices or !npuUOulput (I!O) devices alow the user to put data into

| a computer or receive output from a computer. A terminal is a peripheral that contains both a

keyboard for input and & monitor for output. Other peripherals include printers and plotters.



‘The diagram below presents the basic hardware component of a microcomputer system.

Centrat Pr“gccssing Unit

cryy  |€

. S i 4
1/0 Terminal Secondary Storage

A

- { Random Access Memory
Keyboard - (RAM)

: _ ‘ - 1dp Hard Disk
Monilor e : | | e

&p! Floppy Drive

Printer
e e

‘II-‘Ioppy Drive is the mest common type sccondary storage used in personal compﬁtcr today. Ilaclsas
an external drive .Ifrom_ which the tisérg insért the ﬂoppy disk to store and.rctrieve information. The
ll‘l'oppy disfc cdmcs n three sizéS' 3.5 inches, S. 25 inches and 8 inches. It is char'wterazcd by thin
cm,ular p!asuc shects coated with iron oxide so that magnel:c patterns recorded on :l can be retained.

The surface 15 sumlar to a magnehc tape u‘:ed to record music. The 5.25 inches diskette is conlained
ina square cardboard uwelopc in which it spms The 3.5 inches diskelte is contained in a hard plastic
casc w ith a metal shutter that protects the magnelic media. A floppy disk can store from 80 kilobytes
(0 1.44 megaby tes ofdata Floppy disk system is slower and has less storage capacity than hard disk

system, but its lower cost makes it a popular choice for personal computer uscrs.

Hard disk is made dt" ‘magnclic metal, énd can either be removable or non-removable. The most

common type of hard disk that is found in personal computer today is non-removable. This disk
typically holds from 10 mcgab} tes to 3.2 gigabytes of information. Each megabyte is equivalent to
1,048,576 characlers of information, or roughly 1,800 single-spaced typewritten pages; hence, this is

a very cfficient way to store large volume of information.

Keyboard is an extermnal device that acts as a primary interface between the human operator and the
computer. The keyboard has 3 basic components: the typewriter keyboard which is composed of
alphabet characters; the caleulator pad which is composed of numeric characters; and the function

keys which scrve as special macro key for various software.




Moniior 1s the sereen or video display peripheral and serves as the main output device on a personal
computer, it is used to display textand geaphics information and is avartable in a vavicty of sizes and
types. Monitors can be divided into two broad groups: those designed to display text information: and
those designed to d—is.plny graphics information, such as charts or picture. Within the graphics group,
there are color or monochrome (single color) displays. A high quality giaphic color monitor is

capable of showing high-resolution pattern and is recommended for application in MS-Window,
Excel, or AwtoCAD,

Printer is another common peripheral found in personal computer system. 'i‘hc common types of
printers are dot m;nriic, inkjet and lascr prirmlér, The dot matrix printer produces its image by printing
a grbiap of dots that form the image of a character or symbol. The inkjct printer is similac to the
impact dot l]!&li’ix pi’intcr, inslcéd of u.s:ing the pin..impac{ forcc to ceeale an image it usc ink buhble to
créat_c similar imagé. The inkjcl pri;itcr is much Iigﬁtcr and quict than the impact dot matrix printer.
Today, it is the popular choice duc to it characteristic and wide availability of selection. The laser
printer produées_ its image by means of clectrophotograph similar to the principle of photocopy
machine, The image produced' in the laser prihter is much crispier than the inkjet printer due the high-

resolution capability. Both the inkjet and laser printer can produce color print.
4. OPERATING SYSTEM

: Opéfating syslerhs isa se:l'oi‘contro! program that ménages the comput:cr’s resources and creates a
well-defined soﬂwarc enuronmcnt for cmnputer appllcahons Computer hardware by itself can

per[orm little uscful \mrk A compulcr requires software to be ab!c to commumcatc and do uselul
w ork ‘The first layer of software in a c.omputer system is the opcralmg system. Fhis is what smns or
: hoots up, the machme helps in pulling itself up by its own bootszraps and cslabhshes a prcdcicnnmcd
set of conditions so that appl:cahons can be run. When the computer is turned-on or the :escl button
is pressed, the control is pass lo a‘set of control programs found in the ROM, a ﬁrmwan. store in
computcr chips. These programs perform several tasks: {1) to check if hardware are l‘unclioﬁi'ng
correcily; (2) to load a set of control program from the disk to the memory; and (3) to pass contro! to
a routine which will écccpt the user input. At this poind, the operat_in_g' system is loaded and the user

can execute an application program such as MS-Word, Excel, Power Point, Access, etc.

An operating system by itself has two levels of functionality. The first level is seen by the user
running the applications and utilizing system commands and utilities. At this level, cach Gpcraiing '
system has its own set of command used lo accomplish ffcquently performed tasks such as c0pying
files, renaming files, and formatting disks. Normally, frequently-used functions arc included in the
operating‘sys.iem as'syslem commands. The second is at the programming level.  All operating

systems contain a set of pre-packaged routine that performs the “primitive™ functions necessary in



almost all applications.  Such functions, like seidking a character to the scrcen, reading and \';’rilillg
information from a disk file, and accepting input from the keyboard are common (o nearly all

programs. This level of functionality gives the programmer a sct of siandardized routines to perform
this task.

5. SOFTWARE

The operating system alone renders the computer nearly uscless, unless the user is capable of dircctly
com:mmicating to the hardware.  In order to'use the compulcr'system software is nceded.  Various
softw; are are available for different pumoscs such as MS-Word for word proccsmng, Excel for

Spuadshecl, Power Point for pnsmlahon Access for .dalabasc and l-oxpro for dalabasc
programming. o '

5.1, MSAVINDOWS

AL S'- !deans is lhc most popular operatmg syatcm it dupllcates all the function performed by DOS
ihe defunct operating system of the seventics and elghhes The capability of MS- Wmdow operating
syslcm far excecds that DOS can offer it mosi convement and easy to navigate. Most of the -
commands are rcpruentcd by dcscrlptnc ﬁgurus called icons. Nawgalmg around lhc wmdows could
be achieved ihrough thc use of a pointing devnce ualled ntouse, normally in the desktop environment,
the mouse pointer is seen as outline of an arrow or white amrow. To cxe_:culc a command, the vser
only nced to bring the mouse pointcr to the desired command described by the icon and .press the ri'ghl
bution or doublc chcl\ the lefi button. The exccution starts w;lhout typing any smgle character in the
keyboard, unhke the DOS convunmn that needs lypmg a series of characters comprising the
command. In windows, the computer screen is referred to as the desktop.  When working, the
apphcauon and documents must be in the windows. The w indows on the desktop must also be
arranged. Ifan application is left fora while, the windows are shrunk to an application icon, and still,
the application kéeps running on the background. When an application is shrunk, the windows place

their application icon at the bottom edge of the desktop until it is again restored to window size.

With windows, several powerful applications can be run simultaneously. For example, switching
. from 2 word processing application to a spreadsheet, and then to database application with a few
simple moves while quitting one application and restarting another, can easily be done.

~ Parts of a Windows

Each application and some documents the user choose to work on, open as separate windows. Every

window has some comumon elements, however, not all windows use ali the items.



The elements as illusirated below are the tools for working with the window and the application or

document within the window.,

Controt-menu Minimize
- Titie Window title button
B [t Maximize

Natepad lUnmled]

E' Eile  Edit ut Help

] button
| . : 24— Insertion
4 poimt
| - 8- Mouse
: pointer

1 Window
'l border

Vertical
scroll bar

W‘ndaw corner L Hon‘zontaf scroll r
The Comrol—menu box located in the upper- left cormier of the window is the most usefut menu when
the use of a keyboard is prcferred. The Control-menu_ commands can resize, move, maxmuze,

minimize and close windows, and switch to Task List.

‘The mle bar shows the name of \he application or documenl If more than one wmdow is open, the

title bar of the active window has a different color or mtcnsuy comparcd to the other title bars.

The window title, depending on the typc of window it appears, can be the name of an apphcatnon and

the name of the document, or a placeholder In such case, “unmled" normally appears.

The ment bar lists the available menus. Most applications have a File menu, an Edit menu, and a

Help menu as well as other menus unique to the application.

The Scroll bar can move the parts of the document into view when the entire document will not fit in
the window. With the bar, unseen portion of the lisis and other information that is too long to fit in

the allotted space can also be viewed.

The Maximize and Minimize buitons enlarge the active apphication window to fill the entire desktop or

shrink the window to an icon. Document windows enlarge just to {ill the application workspace and



not the entire desktop. After enlarging the window, the Maximize button changes to a Restore bultos.

Restore button can be used to return the window to its previous size,

‘The Window border is the outside edge of a window. Tt can lengthen or shorten cach side of (he
border.

The Window corirer can be used to shorten or lengthen two sides of a border at the same time.
The War kapace is where most of the work with an application are done. For example the content of

the documents appcar:s in the workspace when starting a wordprocessor. Hence, an appl:cauon can

allow the opening of more than one document window within this workspace.
The sciemon currsor shows where lhc user is in an individual document. It marks the placc 1 the text
or graplucs wher«. the user begins typing or drawing. The arrow-shape mouse pomltl’ appears if you

have a mouse installed. It is used to indieate items the user wants to select with mouse.

Srarting A ppllcario}rs with the Run Command

The Run command isa handy way 0 start applications that you want to run only owaswnally or have

not yet addcd to a group. You can opcn a document at the same time you start the apphcauon

Unless the program file is in your curn.nt path, you necd to know the exact directory location and

name of the program file before you can start the application.

I.  Choose Run from the File menu in Program Manager or File Manager.
" The Run dialog box appears.

2. Type the pathnamc and the cxact Nlename of the program file, including the extension
if there is one.

3. If you want the application to shrmk to an icon as soon as it starts, make sure the Run
Minimized check box contain an X.
4. Choose OK or press ENTER.

52, MS-EXCEL

' Excel is a spreadsheet type of software package that operates under the MS-WINDOWS operating
R *:ystem 1 hc primary document in Excel is called a workbook. The workbook is similar to a ledger
 that stores information and each workbook is made up of sheels. The sheet is virtually divided into
colunm and row; the column run horizontally and denoted by an alphabet starting with A and the row

run vertically and denoted by number starting from 1. The intersection of column and row is cailed

&



cell. The cell is the basic component of worksheet that aceept different data types. The mosl
common data types are character, number, date, logical value and fonnula.

Standard Toeolbar

The standard toolbar that normally appears at the top of screen helps select options. Such options can
open workbook, print and save worksheet, and ask for help. The following is a list of the individual

icons and their respective functions.

Excel’s Standard Toeolbar

——.__Ei;i—‘;;-__ 1T _g';-l.l-le : Function _":
@ Ncw. Work_bbok Creales 3 new workbook
E? - | Open | Opens a document -
EI | Save = _ Saves fhe activ.e worl{book
.. % _P;l_; | | P:;;ts the active \Vb;ﬁb.caols
' E Print Prcview : Shqws the active documént in p.n'nl p:rg:view“;;c—!(;u o
i Speller Ch;:ck; tﬁe sp}_uing of the ldd:ume.nl |
_&é_ Cut . Chts the selectio§ to the CIipbéard
Copy Copies the sclection to the Clipboard | L.
E Paste Places the Clipboard contents at the insertion point




Builon

Ed

Name

Function

Format Painter

Copies and pastes founats for cells and objects

) Undo Undoes the last action or command
v Repeat Repeals the last action or command;

| - this is the same as the redo feature in Word 6
2. AutoSum Inserts the SUM function and shows sum range

Funclion Wizard

Starts the Function Wizard

Sort Ascending

Sorts selected rows in ascending order

Sort Descending

Sorts selected rows in descending order

ChailWizard Activates the ChartWizard
Text Box Inserts text or text box
Drawing Turns the drawing toolbar on or off

Zoom Control

Sets the view of the document

Tip Wizard

Turns the TipWizard toolbar on or off




Button

@)

Name

Help

Funciion

Bisplays Help

|Arial WE Font

" | Font Size

Sets the font for the selection

Sets the font size for the selection

E Bold Boldfaces the selection
B n_;r lialic ltalicizes the selection
——, _ E Underline Underlings the sclcc;;on -
. :—E:m _' Ali.gnl.Leﬂ chl-aligns the selection
% Center Cénfcrs the selection
| % Align Right Right-;i—gns the éeléc‘ion

*E
ol
+.

Center Across
Columns

Centers the selection across columns

(&)

Currency Style '

Changes the selected cells to default cur_rcncy style

Percent Style

Changes the selected cells to default percen't style

gl

Comma Style

Changes the selected cells to default comma style




Button

Name

Funclion
€.0 . . ‘
.60 Increase Decimal Adds one decimal place to the number format
‘).(20 Decrcase Decimal Removes one decimal place from the number format '
: : L Borders Enables you to select a border for the selection
Q] ¥ Color Sets the color for the seleclion
l]'-. )4 | Font Color Sets the color for the selected font




Basic PPavt of Excel Screen
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MS-Excel Basic Operatioh

Tabs

Worksheet

Following the description of the basic operation, the mouse is used as a pointing device instead of a

Ik_éyboard. The word click means the user must pfess the lefl button of ‘thc mouse; double click means

two successive clicks; and enter means the user must press the Enter key in the keyboard. Basic

operation dealt only (o the routine necessary to update the PW4SP data base.

Creating a New Worksheet

When you enter Excel, it opens up to a new workbook, by default it contain 16 worksheets. You can

use any of the worksheets. Even if there is an open workbook, you can still open another by moving

the mouse pointer in the New icon {upper left of the screen below the menu bar). Click on it.

Saving the Workhkook

b .

2. From the oplion available. Select Save.

Move mouse pointer o File menu and click on it to bring the File menu option.



3. Ifthe document your saving is new. The Save As dialog box appear. In the File Name box
type the name of the workbook.

Enter Datain a Cell

1. Tirst select the cell by moving the mouse pomter and clicking the right bution.

-This routine place the inscrtion pomt in the active cell, which is hlghhghted on-screen with
border around it,

2. You can slart entering the data from your keyboard or numeric kcypad

3. To confirm the input, you can press ENTER or move the mouse pointer to the Formula bar
~and click the Check icon,

Editing Ccll Contents

1. Double-click the cell containing the data you wanl to edit. To cdit in the formula bar, click
in the formula bar. In case the formula bar is not dtsp!aycd choose Formula Bar from the
View menu located at the top row of screen.

2. Edit the cell contents.

3. To confirm the modification made in the cell click thc (,heck icon in the formula bar or
press ENTER. 'l 0 cancel edits, ¢lick the X icon in the formula bar or press FSC

Clearmg Cells

1. Setcct a cell or range of cells that you want to clear. .
2. From the Edil meny, choose Clear, and from the option avadablc
“you the choose All, Contents, Formats, or Notes.
Shortcul Press DEL.

To clear cells by dra ggin g

1. Selectacell or range of cclls thai you want to clear

2. Move the mouse pointer in the Sfill handle (lower ri ight comer),
drag the fill handle toward the area of cell or range, then the selected
arca will become gray.

3. Releasc the mouse button.

Copying Cells
. Select the cells conta'i-ning the data you want to copy.
2. From the Edit menu, choose Copy.

3. Scleei the upper- 1eft cell of the paste area.
Beware that any values or formula in the paste area will be replaced.

Undo Command

1. Toundo your tast command, click the Undo button.
From the Edit menu, choose Undo.

Creating Border around Cell
1. Choose the Cell menu from Format menu.

2. Choose the side you want put the border, and then choose type of border.
3. Click OK button.

F 3y
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Deleting Rows and Columns

1. Sclect the row or cotumn
To delete more than one row or column, extend the selection to include
all the rows or columins you want to delele.

% 2. TFrom the Bdit menu, choosc delete (Entire rows or column)
E 3. Click OK buiton
Inserting Rows and Ceolumns
b. Sclect the row or column
To insert more than one row or column, extend Ihe selecuon to include
the number of rows or columas you want 1o insert.
2. From the Edit menu, choose Insert (Entice rows or column)
3. Click OK bution,
Selecting a Sheet or Sheets
To sclect a single sheet, elick the shect tab.
To seleel two or more sheels
I. Click the shoet tab for the first sheel you want 1o select. '
If the sheets you want to select are adjacent, ho1d down the SHI[‘T key
and click the tab for the last sheet.
- If the sheels you want lo select are non-adjacent, hold down the CTRL kt,y
and ctick the olher sheet tabs. .
' Ungrnup Selected Sheets

l. Move the NIOUSE pointer to the sheet tab. Click the left button of the mouse.
2. While the mouse pointer still on the sheet tab, click the nght button and
choase the Ungroup Sheets. : :

.lnser!mg Worksheet

I. Self:cl a sheel or sheets in the \'.orkbook

2. From the Insert menu, choosc Worksheet. . :
The new sheet or sheets will be 1nserted to the ef of the sheet tab you seIccl
Shortcut SHIFT+F!1

De!eting Worksheet

l. Sclccl a sheet or sheets in the workbook
2. Move the mouse pointer to the sheet tab, and click the right button.
3. Choose Delete, and click the OK bulion.

Moving Worksheet Within the Workbook

1. Select the sheet or sheets you want to move.
2. Drag the selected sheet tab along the row of tabs.
A black triangle indicates the place where the sheets will be inserted.
' All selected sheets will be inserted.
3. Release the mouse bution.



Altermate Method

B B —

Select the sheet or sheets you want to move,
From the Edit menu, choose Move or Copy Shect.

Tn the Before Sheet box, select where you want sheets to be mscrtcd.
Click the OK button.

Moving Sheets to Other Workbook

{. Open the workbooks you want to move shects 1o and from.
2. Sclect the sheet or sheets you want to move.
3. From the Edit menu, choose Move or Copy Sheet,
4. In the To Book box, select the destination workbook.
5. inthe Before Shect box, select where you want the shcet or sheets mscrtcd
6. Click OK button.
Altermative Melhod
1. QOpen the workbooks you want to move sheels fo and from.
2. From Window menu, choose Arrange and choose horizontal. :
In the desktop, two workbooks will open in screen spht the warkarea honmntally.
3. Sclect the sheet or sheels you want to move.
4. Hold-down the CTRL key and the right button of the mouse.
A paper icon and black trianglc indicate that you made the move routine aclive.
5. Drag the mouse pointer to the other workbook and select where you want '
- the sheet or sheets inserted.
6.

Release the mouse bulton,

Copying sheets within a workbook

1.
2.

3.

Sclect the sheet or sheets you want to copy.

Hold down the CTRL key and mouse left button, and then drag the selected
sheet tab along the row of tabs. A black triangle indicates the place where
1he copied sheet will be inscried. .

Release the mouse button and then the key.

Allernative Melhﬂd

Select the sheet or sheets you want (o copy.

From the edit menu, choose Move or Copy Sheet.

In the Before Sheet box, select where you want the copicd sheet mserted
Select the Create A Copy check box.

Click the OK button.

Cﬁpying sheets to ofher workbook

R N

' Open the workbook you want lo copy to and from.

Select the sheet or sheets you want to copy.

FFrom the Edit menuy, choose Move Or Copy Sheet.

In the To Book box, select the destination workbook.

In the Before Sheet box, select where you want the copied sheet inserted.

Select the Create A Copy check box. . @
Choose the OK Butten. 2



Printing youy Work

L. From File menw, choose Page Sclup to display the Page Sctup dialog box.
2. On Page Sctup dialog box, their are four option available

Page tab controls page oricntation, scaling, page size, print quality, and
starting page number for the selectcd sheet,

Margin tab controls page margins ¢ and the header and footer margins, and
centér the sheet on the page vértieally, horizontally or both.

ieader/Footer tab controls page the headers and footers for the selected sheel.
headers and footers are descriptive text that print at the top and bottom of
every page in your sheet. You can add, ‘delete, edit, format, and position
headers and footers, and view them as they will print,

Sheet tab specifics which areas of the sheet you want to prml and controls
the print tittes, page order, and dralt quality. Also controls whether
gridlines, c¢ll notes, and row and column heading print. The Sheetab is
displayed if the active sheet is a worksheet or macro sheet.

3. On the Print What, their are ihrec option available.

Selection option prints only ihe sclected cells in the selected shcets
Nonadjacent selections are prmted on scpantu pages. Sclecting this
oveprides any pnnl arcas you have defined for the selected sheets using
Print Arca ophon on the Sheet tab of the Page Setup dialog box.

Selected Sheels option prints the area of cach of the currently sclected sheets,
with cach prml arca starling on a different page. I no print arca is defined
on a separate sheet, the entire sheet is printed.

Entire Workbook option prmts the enfire print arca of all sheets i in the aclive
workbook. If a sheet does not have a print area, that entire sheet is pmmd

4. On the Copies box, specifies the number of copics to print,
. On the Page Range, their are two option available.

Al option print all the pages in the selected sheets, .

- Pagefs) option print the range of pages specificd in the From and To bo:\cs
Page numbers you selected in the From and To boxes aflect which cells
will be printed, not the numbering of the pages upon which they are.
pnntcd To change the numbering of printed pages, ‘specify a number in
the First Page Number box of the Page tab in the Page Setup dialog box.

6. The user have option 1o see the appearance of the print by clicking lhe

Print Preview button.

7. Printer Setup option give the uscr an option to select among the available

_ printer drivers. :

8. Click the OK button to proceed printing.

wn

53.  MS-WORD

MS-Word is m)rd proccssmg type of software. This is analogous of cony crlmg your compmer nto
1ypewmer machine. You have page in which you type character:. you have a ruler that show where
you are as you type across the page. You have tabs stops and margm sellings. The insertion point

moving across the page even acts like the print head moving across the page.

MS-Word offer more advance features that you neced to create from simple to complex 'lypc of

document. When you start Word you will notice almost the identical appearance with that of MS-



Excel. Most of the command are vepresented in terms of icon, in the middle of the workspace were

you enter your text and other object included in your documents.

Starting Word

From the MS-Window environ'mceil 'you can‘ double-click the MS-Word icoh 'in' the MS-Office
program group In some case the MS- Ofllcc adnunlstraior is automatically loadcd at stait-up of
Windows environment. The MS Office admlmstrator menu icons are located in the upper right side

of the screen. You can start MS-Word by chckmg thc icon,

Quiting Word

Move mouse pointer to File menu and click. File sub-menu will appear.

2. From the File sub-menu, move mouse pointer to Exit option and click.

The MS-Word environment wilt normally terminate. In somg cases, if some active
documents has not yel been save. MS-Word give the user's option to save the dooumcnts

—

Shnd ard Tooibar

The standard toolbar which normally ShO\Vﬂ at the top of screen helps you select the ophon from
this toolbar The user’ s can open new document, open existing document, print and save document,
and ask help to farther undcrstand some function or procedure to accomplish desired task. Using the
toolbar 5pccd-up the desire task instead of using the menu (located at the top of the scrcen). The

following shows the list of standard toolbar icons and their function.

MS Word Standard Teolbar

Button“ Name C . . Function

I D New - Creates a new file based on the Normal template

(2 Open - Displays the Open dialog box so that you can select an
‘ existing file to open
E’ . Save ' Saves the cument document

. % ‘ Print Prints the current documeni

& Print Preview Activates Word's print preview features




7 Vllu!ton

| Butten  } Name | Function
Spclling Initiates a spelling check
M—_“:ﬁ | Cut - Cuts selected material to the Windows Clipboard
: "_'4 | C)o;;yu - Copies selected material to ih_e (;Ilpbo—a;
Paste

Pastes material from the Clipboard into your document

Format Painter

Copies the fonmatting of a selection to the fext you specify

K7 Undo UIndoes the commands you select from the list presented
R | Redo Redoes l'he con‘imaﬁds you select from the !isf presented
@ AutoFormat Foﬁn:até yoﬁr d?cuzrient autdﬁlatically-
!n‘serl. Aﬁto Text ln‘serl.s aﬁ Auio 'i‘e%(t eﬁtry.
Insert Table Inseris a tablé into your document

&

Insert Excel

Inserts an Excel worksheet into your document

Worksheel
—
== Columns Formats your document using columns
@ Drawing QOpens the drawing application and enables you to draw a
picture in your document :
@ Insert Chart Inserts a chart into your document




Bnllon Name l'unc(Ion 7
@::J[g Zoom Control Scales your view of the document by the percentage you
select
G 1 : .
9 Help Activates context-sensitive help
14 TS

MS-Word Bastc Operation
Opening and Existing Document

1. Click the Open Folder icon (nomxally sccond from the left) to bring up the open
dialog box.
2. Inthe Open Dialog box, sclect the ﬁle you to open {rom File \Iame combmahon
: box.
3. Chick the OK bullon

Changmg the Formal of the Text

1. Click thc arrow bullon to the nghl of the fom box to bring the hsl of available font.
. 2. Scroll through the list box by clwkmg on lhc scroll bar, and select a font by cl:ckmg
. onit.
C 3 Begm typing. The text will appear in the font you _]LlSl selected.

Changing the Font Size

1. Click the arrow buiton to the right of the fon! size box to bring the list of available size.
2. Scroll through the list box by clicking on the scroll bar, and select a size by clicking on it.
3. Begin type. The text will appear in the font size you size selected.

Choose a Style

. Perform any of the followmg procedures to change a font style:

» Click on the button labeled B to set the bold feature on.
Yo also can press Clrl+B from the keyboard.

o Click on the button labeled I to set the ifalic feature on.

- Youalso can press Clri+! from the keyboard. .
¢ Click on the button labeted U to set the underfined feature on.
. You also can press Ctrl+lJ from the keyboard.

s Click on the button labeled B and I to sel both bold and italic features

You also can press Ctrl+B followed by Ctrl+I from the keyboard.

Setting Special Effects
You can use a varicty of special text effects:
¢ Sirikethrough

¢ Superscript
¢ Subscript
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o 1lidden
e Small caps
+« Allcaps

To set any of these features, use the following procedure:

1. Open the Farmat menu and sclect the Fond item,

2. If the Fonts tab is not on top, click on it

3. In the Effect group box, sclect the cheek box that represent the special effect
“you want to turn on.

4. Click the OK buiton.

5. Begin typing. Your text appears with the ﬂpmal cffecet you sclected.

Setting the lndcmatibn

BN e

Opcn the Formal menu and seTect the Paragraph item.

If the Indents and spacing tab is not on top. click on it

In the indentation group box use the Left and Right spin boxes to set the indentation

from the left and nght margins. Click on the arrow buttons until the measurement is correct,
or sclect the text in the body by highlighting 1t wrth the mouse md then type exact
measurement you want.

To set first line or hanging mdentauan open the Specnl drop -down list box by

chckmg on ils arrow, and select thc appropriate item, Use the By spin box to sct the
measurement for the first ine indentation or the hanging indentation,

Click the OK button. Your current paragraph takes on the indentation you just sct.

T’ach subsequent paragraph you create takes on this pattern, unless you reset the

indentation using the dialog box. : :

Setting Line Spacing_ L

el e

Open the Format menu and select the Paragraph item.

If the Indents and Spacing tab'is niot on tep, click on it. - a '

In the Spating group box, use the Before and After spin boxes to set the distance in

points from the previous paragraph and from the following paragraph. Click on the amew
buttons until the mecasuremnent is correct, or selecl the text in the box by htghhghlmg it with
the mouse and then type the exact measurement you want co

To sel ling spacing within the paragraph, open the Line Spacing drop- down fist box by

- clicking on its arrow, and select the appropriate item. Then use the At spin box to sct the

measurement for number of lines or distance between lines, whichever is active.

Click the OK button. Your current paragraph takes on the line spacing you just set.

Fach subsequent paragraph you create takes on this pattern, unless you resct the line spacing
using the diatog box. '

Copying and Inserting Text

B2 N

Highlight the text by dragging the mouse pointer over the text to be selected.

Move pointer to Copy icon and click on it.

Move mouse pointer to the p!ace were you would like the insertion take place.

Move mouse pointer to Paste icon and click on it. Alternatively, you can press the right
button of the mouse to bring the menu option., seleet the paste by click on it

Undoing arnd Redoing

If you do make a mistake, you can undo it by selecting the Undo option from the Edit menu.



‘Fhis procedure undocs the last change you made to the document. Word always will add the name of

the operation you are aboul to undo as the second word of the Undo menu item. If you cannot undo

anything, this option change to Can’t Undo and is dimumed.
Overstriking Fext

There are times, however, when you want to type over existing text. To switch to this‘ediling mode,
press fhe Insert key in the keyboard. When you type, the characters you type replace any characters

to the left of the insertion point. To turn off the overstrike mode, press the Insért key again,

Deleting Text

Use mouse pointer to highlight the desire text and press the Del key from the kcyboérd.

Insert Fi!c

l. Move mouse pointer in the Iocauon were you would hke the inscriion take p1acc
" Trom the Insert meny, select File option.

3 From the File name combination box, selecl the ﬁle you would hke to mserl
- Chick {hc CK bulton.

Crcating the Header {ir Footer

l. F rom the View meny, choosc lleadcr and Footer.
2. The Header and Footer toolbar appear, click the switch between Header
and Footer button. "the header and footcr areas are cnclosed by a nonprmtmg
dashed line.
3. Do one or more of the followmg, : ‘ '
Text - You can type the text within the dashed line that nurround the hcadcr or footer area.
Page Number - Click the icon.
Curreat Date - Click the icon.
Current Time - Click the icon,

4. To return to the document, choose the Close button on the Header and !*ooler toolbar or
double-click the main text area

Previewing the" Décument

. From the Fl!c menu choose Prmt Preview.
While in the print preview mode, you can perform the following options.
. a) You can print the document by click the Print button.
b) You can switch the magnlﬁer on and off by clicking on the magmﬁer button.
" ¢) You can switch to a one page view by clicking the One Page button.

d) You can switch to view multiple pages by clicking on the Muitiple
Pages Bution and dragging across the grid that appears, releasing the
mouse button when you have the multiple-page view you want to use.

) You can zoom in or out on your document by adjusting the zoom
percentage in the Zoom Control drop-down list box.

£} You can switch the view of the ruler on and off by clicking on the
View Ruter button.

£) You can squceze a small amount of text on the final page into the
lhe outer pages by clicking on the Shrink to Fit button.

{igtad
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h) You can expand the previcw sereci to show only the page, the
toolbar, and the status bar clicking on the Full Screen bulton.
1} You can exit the previcw mode by clicking on the Close bulton.

Printing your Docmueut

1. From the File ment, choose Print ophon
A Print dialog box appear.

2. Inthe Print What drop-down list box. This option enables you to print the
document or several items ancillary to the document, such as Suninary Info,
Annolation, Style, Autolext Entrics, and Key Assignments.

3. Use the Copies box to enter the number of copics to print. T

4. Use the Page Range oplion to determine how much of the documcm to print.
You can print All the document, the Crrrrent Page, or selected Pages.

5. Cheek the Coflate Copies check box to finish the first set of copy before
printing the sccond copy.

6. When all it sct corvectly, close ali the dialog boxes you have opcn
and ¢lick OK button, the printing process begin.

6. PWAST DATA FILES

Data files are collection ‘I)f information relevant to ihc prcparatien of.PW'tISP Dété files are logically
group into thrcc major areas of information. The fi rst group of mformahon are thc bace data that are
compotcd of mformalton derived from surv:,y, ocular inspection, and emslmg uﬂormatmn from the
provincial and national agengies. lhu second group of information are the kcy parametc: data that are
composed of information derived I‘rom apphcablc policics, assumption, water test result, and current
cost of commodtly The third group of mformatwn arc the presemauon of data which derived From
the prevlously mem:oncd groups of information’s, thls data are processed and thcn logically arranged
to show provmc:al proﬁlc exwimg facilitics and service coveragc past financial performance, future

r;qulrcmcm of the relevant sector, cost ¢stimates for future sector developiment, and financial

arrangemem

0.1. Base lhfofmaliﬂn

1. Socio-economic Data (Socio-cconomic.xls)

a) Municipal/City Status and No. of Barangays ( Muncity Status (P.1.1) }
b) Past Population { Past Populatlon (P.121) & (P.1.22))

¢) Projected Population ( Projected Population (P.1.3.1) & (P.1.3.2) )

d) Household ( Houschold) {P.1.4))

€) Services { Services (P.1.5))

) Occupation ( Gecupation (P.1.6))

g) Family Income { Family Income (£.1.7} )

h) Expenditure ( Expenditure (P.1.8) )

i) Education { Education (P.1.9))

2. Land Use Data (L.anduse xls)
a) Existing Land Use ( Existing Land Use (P.1.2.1})



6.2,

6.3.

b) TFutvre Land Use ( Future Land Use (P.2.2) )

3. Health Data {11calth.xls)

a) Morbidity, Mortality and Infant Mortality { Morbidity and Mortality (P.3.1) )
b) Facility ( Facility (P.3.2) ) ¢
¢) Practitioner { Practitioner (P.2.2)) o : -

4. Water Resource Data (Water So'u'rcc.:;ls) ,

a) General Information ( Gen. Info (P.4.1) )
b} Water Sourcc Information ( Source Info (P.4.2))

5. Water Suppfy S‘yerems Data (Water Supply xls)

a} Levell l"acrhty( Level | (P 5. l)) ,
b) Level Il System (Level H (8.5.2.1) & (8.5.2.2))
c} Level il ‘qulem (Level 1(S.5.3.1),(8.5.3.2), (8.5.3.3) & (8. 5 3 4))

6. Environmental Sammnou Data (Samtauon xls)

a) Houschold Toﬂets ( Houschold ‘Ioﬂets (P.6.1})
b) School & Student { School&Student (P.6.2) )
¢} Schoo! Toilet (School Toilet ®.63))
d) Public Toilet ( Public Toilet (P.6.4.1), (P.6.4.2) & (P 6.4.3))
¢) Drainage Facility { Drainage Facility (P.6.5)) -
) Solid Waste Collechon and Disposal { (M) Solid Waste)

7. Imesrmemi)am (lnvcstmcnt xls) ‘ : : o : g

a) lmomc & Expenditore (P.7.1)

b) PasllRA(P?Z) P

¢} Available Funds for Capltal Fxpcndlture (P.7.3)

d) Scctor Previous Investment (P.7.4)

¢) Sector . Allocation in the AIP (P.7.5)

) Allocation of the 20% Dey. Fund (P.7.6)

£) Financial Indicator of WD (P.7.7)

h) Loan Statusof WD (P.7.8) ' '

i) Affordability in Water & Samtauon Services {P.7.9)

Key Parameter

1. Key Pammelers (Key Parameter.xls)

a) Key Paramefer (Key Parameter) _
b) Level I - Safe and Unsafe (Level | Safe and Unsafe)

¢) Well Source Composition (Well Source Composition)
d) Unit Cost {(Unit Cost)

¢) Scoring Factor (Scoring Factor)
) Annual Investment { Annual Investment)

Data Prescentation g

I. Provincial Frofile (chapter-3.xls}



a) Outline of City sind Municipalitics (MTable 3.1.1)
b)Y Current Land Use (MTable 3.2.1)
¢) Dininage Arcas and Flow Rates of Major Rivers (M Fable 3.2.2)
d) Distribution of 1 louscholds by Income Class (MFigure 3.3.1)
¢) Population Distribution by Occupation (Figure 3.3.2)
f) Population Distribution by Highest Attainment of Education (MFigure 3.3.3)
g) Proviicial Qutting on Public Services (M Table 3.3.1)
1) Public Facilities and Services by Municipatity (MTable 3,3.2)
i) Previous Population Development of the Province (MFigure 3.4.1)
i) Previous Population Development by Municipality (MTable 3.4.1)
k) Present Population Distribution (MFigure 3.4.2)
1} Outline of Urban and Rural Areas i in the Province (MTable 3.4.2)
m) Houschotd Numbers and Household Sizes (MTablc 3.4.3)
n) Number and Rates of Ten Leading Causes of Morbidity,
Mortality and Infant Monal:ty (MTable 3.5.1) :
o} Reported Cases and Deaths of Notifiable Water Related Discases (M 1ab!e 3.5.2)
p) Municipal Solid Waste Collection and Disposal, and
‘Scrvice Covcragc in 1994 (MTab!e 3o
q) Number and Ratio of Population to Health Facilities
" and/or Medical Practitioners (STable 3.5.1)
1} Types of Drainage Facilities (STable 3.6.1)
s) DENR Water Quality Criteria®Water Usage and Classification
for Fresh Water (STable 3.06.2)

2. Frrslmg Fac:!mes aind Service C memge (chaptcr 4.xls)

a) lnfoxmahon on Fxt;tmg 1.evel 1 ’Systems (MTable 4.1, 2)
b) Infonnanon on Water District (MT: able 4.1.3)
¢) Information on Existing Ievel 11 Systems (MTable 4.l. 4)
d) Information on Existing Level I Facilities (MTable 4.1.5)
¢) Waler Supply Service Coverage by Municipality in 1994 (MTable 4.1.7)

1) Water Supply Service Coverage by Municipality (MFEigure 4.1.1)

g) Sanitation Facilities and Service of Household Toilets, Urban 'md
Rural, 1994 (MTablc 4.2.1) . '
h) vamc:al Serwcc Coverage of Househoid loﬂek Pacﬂltlcs 1994 (MTtigure 4.2.1)
i) Schoo! Toilet Facilitics and Service Coverage in 1994 (MTahIe 4.2.2).
i) Public Toilet Facilities and Servicé Coverage in 1994 (MTable 4.2.3)
k) Details on Existing Level I1I Systems (STable 4.1.1 Sheet 1 to 4)
1) Details on Existing Level II System (STable 4.1.2 Sheei 1 to 6)
m) Number of Level I Facilities by Safe and Unsafe Classification (STab!e 4.1.4)
n) Bstimation of Unserved Population by Municipality (STable 4.1.5)
o) Estimation of Population Covered by Safe and Unsafe Source
by Municipality (S8Table 4.1.6 Sheet i 102)
p) Sanitation Facilitics and Service Coverage of tlousehold Toilels
by Type, by Municipality, Urban and Rural, 1994 (STable 4.2.1)

3) Past Financial Performance in Waier Supply and Sanitation {chapter-6.xls)

a} Actual Income and Expenditures, (MTable 6.2.1)

b) Internal Reyenue Allotment to the Province (MTable 6.2.2)

¢) Allotted Funds for Capital Expenditures (20% DF) (MTable 6.2.3)

d) Actual Amount of Sector Investment to the Prov;nce by Concemmed Agencics
(MTable 6.3.1)

¢) Annual Investment Pian 1995- i999 (\&Table 6.3. 2)

f) Sector Allocation in the Annual Investment Plan (MTable 6.3.3)



£)  Allocation of the 20% Development Fund (MTable 6.3.4)
h) Financial Indicators of Provincial/Municipal Watuwork-; in the
Province (MTable6.4.1) :
i) Loan Status of Provincia¥Municipal Walemorkq (M lablc 6.4.2) :
j)  Aftordability in Water Supply and Sanitation Qerwccs (Mtab!c 6.6.1)
k) Income and Expenditure (STable 6.2.1) {7
1} PastInternal Revenue Allotment for the Provmcc 5 lablc 6.2, 2) : e

4 Warer Sam ce Demei’opmcm (chap!er 7. xls)

a) Existing Ground\-.alcr Sources in the vamcc (MTablc 7.1. 1)
b} Work Flow of Groundwater Availability Map (SFigure 7.3.1)
c) Ixisting Spring Sources by Municipality (STable 7.4.1)

d) River Information and Related Data (STable 7.5.1)

¢} Water Quality Analysis Results (STable 7.5.2)

0) Existing Well Sources (STable 7.6.1) '
g) Standard Spec:ﬁcahon of Wells by Mumclpahty (‘STable 7.6, 2)

5) Future Reqmrement in Water Suppl} and Smufatron szronmen! (chapter 8 xls)

1) Provmcral Scctor Targels (MTah[e 8.2 l) ,
2) Base Year Scrvice Coverage of Water Supply (M1 ablc 8.2.2)
3) Base Year Service Coverage of Houschold Toilets (MTable 32, 3)
4) Base Year Service Coverage of Public School Toilets and
Public Toilets (M"l able 824)
5) Base Year Serwce Cov Lrage of Mumcnpal Solid Waste System in 1994
(MTable 8.2.5) ‘ ‘
6} Regional Popu!alton I’ro;ect (M1‘ab!e 3. 3. l) : ‘ : o ‘ @
7) Municipal/City Population Projection (MTablc 8.3. 2) &
8) Municipal/City Population for the Year 2010 & Growth Rates (MTable 8. 3 3)
9) Past and Projected Popu!ahon by Current Municipality/City (MTable 8.3.4)
10} Past and Projected Population by Urban and Rural Area o[‘Currcnl
, Mumcypalllnyﬂy (MTable 8.3.5) :
11) Projected Public School Fnrollment and Number of Public Utility
by Mumcnpahty (MTable 8.3.6) .
12) Population to be Served by T: arget Year (Water Supply) (MTable 8.5.1)
13) Additional Number of Houscholds to be Served by Target Year
"~ (Household Toilets) (MTable 8.5.2) .
14) Additional Number of Public School Student to be Served by
- Target Year (School Toilets) (MTable 8.5.3) .
15) Additional Number of Public Utilities with Samtary Toitets
by Targcl Year (MTable 8.5.4)
16) Population to be Served by Urban Sewerage in Phase 11 (MTable 8.5.5)
17) Additional Number of Urban Households 1o be Served by
-+ Municipal Solid Waste System in Phase | {MTable 8.5.6)
18) Water Supply Facilities Required by Target Year (MTable 8.6.1)
19) Sanitation Facilities Required by Target Year (MTable 8.6.2)
20) Number of Garbage Collection Trucks Required in Phase I (MTable 8.6.3)
21} Estimation of Base Year Service Coverage of Water Supply (STable 8.2.1)
22) Population Coverage in Phase | Provided by Served Population
in the Base Year (STable 8.2.2) ' : !
23) Number of Househo!ds Served by Sanitary Toilets inthe g
Base Year (1994)}{STable 8.2.3)
24) Number of Public School Student Served by School Toilets in the



$3asc Ycar (STable 8.2.4) .
25) Number of Public Utilities with Sanitary lonlus in the
Base Year (1994) (STable 8.2.5)
206) Itouscholds Coverage in Phase I Provided by Existing Facilities in the
Base Year ([louschold Toilets) (ST '1bIe 8.2.0)
27) Public School and I‘ubllc Coverage in Phase I Provided by
Exisling Facilitics in the Base Year (STable 8.2.7)
28) Census Population and Projected Population (STable 8.3.3)
29) Municipal/City Population Projection (STable 8.3.4)
30) Municipal/City Populahon for the Year 2010 and Estimate
Growth Rates (STable 8.3.5) -
3 l) Past and Projected Poputation by Cmrcnt Mumcapahty/(‘ lty (‘S I'able 8.3.6)
32) Past Population Development by Urban and Rurat Area (STable 8.3.7)
33) Population Projected by Urban and Rural Arca {(STable 8.3.8)
34) Past and Projected Popualation by Urban and Rural Area of Current
Mumupahtnyny (STable 8.3.9) '
35) Projected School Enrollment by Y\’lumc:pahty by Targct Year (ST-ablc 8.3.0)
36) Projected Numbcr of Public Utilitics by Mummpahty by Target Year (STable 8.3.7)
k¥ Populahon to be Served by Level Il System in Phase | (STable 8.5.1)
38) Population to be Scrved in Phase § (Water Supp]y) {STable 8.5.2)
19) Population’ to be Served in Phase ) (Wa!er Supply) {STable 8.5.3)
40} Additional Number of Houscholds to be Serv. ed in
Phase I (Household Toilets). (STable 8.5.4)
41) Additional Number of Houscholds to be Served in
. Phase Il (Household Toilets) (STable 8.5.5)
42) Additional Number of Public School Students ID be Ser\ ed in
Phase [ and ¥ (School Toilets) (STable 8.5.6) '
. 43) Additional Number of Public Utilities w:th Samtary i‘oﬂcts m
@ Phasc | and 1L (STable 8.5.7) :
. 44) Urban Water Supply | Facilities chu:red by T argct Year (STab‘lc 8.6. l)
45) Plan for F\(panswn of Exlslmg Level 11 Systern (STable 3.6.2) ,
© 46) Rural Water Supply Facilities Required by Target Year (STable 8.6.3)(a)
47) Rural Water Supply Facilitics Requiréd by Target Year (STable 8.6.3)b)
48) Urban Household Toilets Required by Target Year {(STable 8.6.4) -
49) Rural Household Toilet Required by Target Year (STable 8.6.5)
- 30) Public School Toilets Required by Target Year (STable 8.6.6)
51) Public Toilets Required by Target Year (STable 8.6.7)

6) Cost Estimates for Future Sector Developinent (éhapter- 10.xls)

a) Price of Major Materials by Facilities (MTable 10.2.1)

b) Construction Cost of Water Supply Facilities Required for
Phase [ (2003) (MTable 10.3.1)

¢) Breakdown of Community Devetopment and Training Cost (MTable 10. 4 1)

d) Unit Cost of Level 1 (Gravel Packed Deep Well — 40m Depth) (STable 10.2. 2)

¢) Unit: Cost of Level I (Natural Gravel Packed Decp Well-40m Dcpih)(STab]e
10.2.2.b)

) Unit Cost of Level ](Gravel Packed Deep Well — 80m Depth) (STab!e: 10.2. 3 a)

g} Unit Cost of Level 1 (Natural Gravel Packed Deep Well--80m Depthi(STable

16.23b) - .
h) Unit Cost of Level | (Gravcl Packed Deep Well - 120 Depth) (STable 10.2.4)
@ i} Unit Cost of Level I(Natural Gravel Packed Deep Well-120m Depth}(STable
10.2.4.b)

i} Umt Cost of Level 1 (Deep Well Rehabihlallon ) (STable 10.2.5)



k) Unit Cost of Level I {Shallow Well - 18m Depth) (STable 10.2.6)

iy Unit Cosl of Levet 1 (Spring Development) (STable 10.2.7)

m) Unut Costof Level I {600 Service Population) (STable 10.2.8)

n) Unit Cost of Level HE (5,000 Service Population) (STable 10.2.9)

o)} Unit Cost of Leve! 11 (10,000 Scrvice Population) (STable 10.2.10)

p) Unit Cost of Level 111 (15,000 Service Population) STable 10.2.11)

q) Unit Costof Hush Water Sealed with Septic Tank Toilel (STable 10.2.12)

r)  Unit Costol Pour Flush with Double Pit Latrine (STable 10.2. 13)

sy Unit Consirucnon Cot ofVcnhlatcd !mprow Pit Latrine (STable 10. 2 l4}

1) Unit Cons{rucuon Cost of Pit Lafriric (STable 10.2.15)

u) Unit Cost of School Toilet (STable 10.2.16) :

v) - Unit Cost of Public Toilet (STable 10.2, 17 -

w) Cost of New Laboratory (STable 10.2,18).

x) Cost of Upgrading Laboratory (S1 able 10.2.19) , '
y) Construction Cost of Water Supply Facilities Reguired for Phase | i (q Table 10.3.2)
-2} Cost of Sanitalton Facilitics Required for Phase 1 (STable 10.3.3)

aa) Cost of Sanitation Facilities Required for Phase 11 (STable 10.3.4)

D Fiuauci‘a".{ Akrangemeufs (chap-_l l.x!.s)l

a) Pro_[ca,ied lntcrnal Rcwmlc Allotment for Medium-Term
Secctor Dev cIopment (MTable 11.2.1) . R
b) Projected Allotment of IRA to the Relevant Sectorby
. Component, 1996- 2000 (MTable 11.2.2) ,
¢) Financing Requirements by Sector Component for the Province (NlT"lbk 11 3 l)
d) Additional Fund Requirement for Medium-Term Plan (MTable 11.3.2)
¢) Intemal Revenue Allotment for Water Supply and Sanitation Sector é |
- by Municipality (Medlum -Term Developent 1996-2000) {(MTable 11.3. 3) :
1} Relationship between Funding Levels and Percent of Coverage
for Water Supply Sector {(MFigurc 11.4.1) |
g) Relationship between Funding Levels and Percent of Coverage
for Sanitation Sector (MFigure 11.4.2)
h) Municipal Investment Need Ranking for Urban Water Supply (MTable l 14.1)
i} Distribution of Provincial IRA to Mumc:pallty for
Urban Water Supply (MT able 11.4.2)
§Y Municipal Investment Need Ranking (MTabie 1 4 3)
X) Percentages for Annual Investment (STable 11,3.1)
I) Comprehensive Investment Need Ranking of the Municipalities (S [able l 1.4.1)
m) New Cost Sharing Arrangement Between NG and LGUs (MTable 11.5.1)
n) GOP-Assisted Leve! I Water Supply and Sanitation Project Cost (MTable 11.5.2)
o) Cost Sharmg for the Project 9Case 1): 1997 Price Level (MTable 11.5.3)
p) Cost Sharing for the Project (Case 2): (MTable 11.5.4)
q) Available IRA for GOP-Assisted Level I Water Supply and Sanitation Project for
Eligible Municipalitics (STable 11.5.1)
1) Available IRA for GOP-Assisted Urban Sanitation Project for Eligible
Municipalities (SFable 11.5.2)
s) Total Available IRA for GOP-Assisted Level I Water Supply and Sanitation
Project (STable 11.5.3)
t) Investment Program of GOP-Assisted Level | Water Suppiy and Sanitation
Project (STable 11.6.1)
u) O&M Cost for Level 1 Facilities (STable 11.6.2) &
v) O&M Cost per HH/Month by Facility and Proportion to Monthly Family
Income (STable 11.6.3)



w) Family Income (STable 11.6.4)
x) O&M Cost for Rural Sanitation (STable | 1.6.5)
y) O&M Cost Tor Urban Sanitation {STable 11.6.6)

7. I)J\TA:FILES LINKAGES

L. mkagcs are !oglcal connccuon between rucords in the data files. 'lhrough lmkdgcs onee the usei’s
updates the source data, all data in the sircams of Imkagcs are dynamically updated. Linkages arc the
convenient lools ol updahng related data, these also shield ihe vser's from the complexity of formula
manipulation. th the aid of lhc data hnkagcs e user’s can conccntra!c more in validating the

souree data,

The folfowing table lists the logical connections for cach worksheet.
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